Editing Object Databases

11

LookoutDirect creates the native database of an object automatically when
you create the object. The native database is documented at the end of each
object class definition in the online help and in the LookoutDirect Object
Reference Manual.
You can create new data members through aliasing, or modify the
parameters of any existing native data member. These parameters include
such things as alarm setpoints, deviation filters, scaling factors, historical
logging, and alias names.
Note Any object in LookoutDirect can have its native database modified. However, this
is most practical for objects with large native databases, such as driver objects and
DataTable objects.

Editing Database Parameters
1.

For the purposes of this illustration, create a Modbus object, the same
way you created the a Pot object. Use the name PLC_1 for your object,
and accept the default parameters.
The Modbus object can be added to your system without a physical
connection while you are learning to use LookoutDirect. Let the
default settings stand when you create the object.

2.

There are two ways to access the dialog box you use to edit a database.
•
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From the LookoutDirect menu bar, select Object»Edit Database.
In the Edit object database dialog box, navigate to your demo
process running on your local computer and select PLC_1.
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•

In the LookoutDirect Object Explorer, right-click on the object you
want to edit the database for, and select Edit Database.

The following dialog box appears.

3.

Follow these steps for each data member to be configured:
a.
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Identify the desired data member by entering it into the Member
data field. If you are modifying a data member that has been
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previously configured, you can select it from the Configured points
list box.
For this example, select 40011 as the modbus data member.
Enter FlowRate as the alias.
Parameter fields automatically change depending on the data member you select.
LookoutDirect automatically determines whether the data member is logical or numeric, and
presents you with the appropriate parameter attributes.

Note

b.

Configure appropriate parameters shown in the following
illustration. See the individual parameter sections in this chapter for
details on setting each parameter.

c.

Select Save or Update. (If you are modifying a data member that
was previously defined, the Save button changes to an Update
button.)

LookoutDirect stores all the new parameter settings for the specified data
member when you select Save or Update. In addition, LookoutDirect
adds the modified data member to the Configured points list box for
future reference. LookoutDirect immediately reflects these changes
throughout your configuration.
4.
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Select Quit to exit the dialog box.
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Numeric Member Parameters
The following diagram and paragraphs describe numeric data member
parameters. Logical data members, covered in the following section, share a
number of the same parameters.

Alias renames any native data member. You can think of an alias as a sort of
nickname. For example, the Modbus driver object includes the native data
member 40011 that represents an analog input. You can give this native data
member an alias like FlowRate. From then on, you can reference the alias
FlowRate instead of its native name 40011. All associated parameters (such
as Scaling) are also applied to the alias value.
An alias is a good way to insulate your LookoutDirect configuration from
changes in your PLC, RTU, or I/O configuration. For example, consider a
flow transmitter wired to an analog input at 40011. You can give 40011 the
alias name FlowRate, just as you did in the example. Multiple control panels
can then display the FlowRate data member and numerous other objects in
LookoutDirect can use it. If you later rewire the transmitter to the analog
input at 40012, you need only modify the alias FlowRate to reflect the new
I/O address. LookoutDirect instantly reflects this change everywhere
FlowRate is used.
You can modify all associated parameters of an existing alias except the alias
name itself. If you attempt to modify an existing alias name, the Update
button changes to a Save button and you will only create a new alias.
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Most developers implement aliases on objects with large native databases,
such as driver objects (like Modbus and Tiway) and DataTable objects.
An alias is optional in some instances. You can apply alarming and logging parameters
to any native data member and save it to the Configured points list without giving it an alias
name. Scaling, however, operates somewhat differently. In order to read scaled data, you read
it from the alias, not the native data member.

Note

The Description appears as the message text in the alarm window. It can have
spaces, and it can be lengthy. You do not have to enter quotes in this field.
Prefix and Suffix are part of the description, but do not appear in the alarm
window. They are just additional descriptive text.
Define Scaling by entering Raw units and Eng. units. The raw numeric data
member is converted (scaled) to an engineering unit value. The PLC in this
example generates a raw value ranging from 6,400 to 32,000. LookoutDirect
converts that raw signal to range from 0 mgd to 200 mgd. The conversion is
linear. See your hardware specifications and calibration records for the
minimum and maximum raw units associated with analog devices. If you
leave the Raw units and Eng. units fields blank, LookoutDirect performs no
scaling on the signal.
In order to scale this data, you can use an alias in combination with the native
data member. Read or write the raw units by connecting to the native data
member, and read or write out the engineering units from the aliased value.
Deviation filters out insignificant variations of numeric signals. The
following figure shows two values plotted on a trend. One line is the raw
unfiltered value. The other, stair-stepped line, represents the filtered value
after passing through a Deviation of 2.
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The Citadel database also uses Deviation as the criteria which triggers
logging of new historical data to disk. See Chapter 7, Logging Data and
Events, in the LookoutDirect Developer’s Manual for more information on
logging data.
Use the Forced data field to manually enter a constant value for the data
member. When you select the Forced checkbox and enter a value in the field,
LookoutDirect forces the engineering unit value to be equal to the value you
entered, regardless of the actual value of the native data member. You might
use this when a sensor fails or during sensor maintenance, or any time a PLC
receives a bad signal from the transmitter.
Use the Alarm condition parameters to define alarm limits and their
associated priorities. LookoutDirect compares the alarm setpoints to the
engineering units value (that is, the post-scaled, post-filtered number). If you
do not enter scaling parameters, LookoutDirect applies the alarm parameters
directly to the raw signal.
You can assign an alias or native data member to any existing alarm Area or
you can create a new Area. To create a new Area, enter the new area name
in the field. See Chapter 9, Alarms, in the LookoutDirect Developer’s Manual
for more information on alarms.
Use the alarm Deadband parameter to prevent fluttering between alarm and
normal states when the signal value hovers near an alarm limit. The following
figure shows a value plotted against its Hi and Lo alarm setpoints.
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Alarm
High

150.0
138.0
Normal
Normal

Low

72.0
60.0

Deadband
Alarm

LookoutDirect generates an alarm the moment the value violates the Hi or Lo
alarm setpoints. The alarm returns to normal when the value drops below the
high alarm setpoint minus the Deadband, or goes above the low alarm
setpoint plus the Deadband. The Deadband also applies to all HiHi and LoLo
alarm limit setpoints.
The Log to historical database parameters define how long to store a value
in the Citadel database on your hard drive. If you do not select this option,
LookoutDirect does not log the value to your disk. If any scaling or filtering
parameters are defined, LookoutDirect logs the scaled, filtered value (that is,
the engineering unit value).
Tip If you intend to display data with a LookoutDirect Hypertrend object, you must log the

data to the historical database.
When you log data, it will go to the database directory you set up in the
Create Process dialog box.
See Chapter 7, Logging Data and Events, in the LookoutDirect Developer’s
Manual for more information on logging data.

Logical Member Parameters
Some of the parameters of logical data members are different from those of
numeric data members. Scaling of a logical signal consists of the Invert
Logical Signal checkbox. When you choose this checkbox, an ON value is
represented by an OFF value, and so on. When you do not select it, ON is ON
and OFF is OFF.
© Automationdirect.com
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A logical database is shown being configured in the following figure.

Alarm parameters of a logical signal include the alarm Area assignment field
and the Generate Logical Alarm checkbox. When selected, the data member
generates an alarm whenever the value is ON; the alarm condition clears
whenever the value is OFF. Notice that if the Invert Logical Signal checkbox
is selected, the value used here is the inverted value. See Chapter 9, Alarms,
in the LookoutDirect Developer’s Manual for more information about alarms.

Text Member Parameters
The text data member database contains only Alias, Member, and
Description fields. You can log text data to the database, but the only way to
query for the logged text string is though the LookoutDirect SQLExec object.
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Importing and Exporting Object Databases
Use the import database service to copy database member parameters from an
Excel spreadsheet file directly into an object. Use the export database service
to copy an object database into an Excel spreadsheet file. This is what you can
do using these services:
•

Export object database parameter definitions to Excel for the purpose of
documentation.

•

Export an object database to Excel, perform global replacements on data
member parameters, and then import the changes.

•

Create a name list in Excel or in an application that exports to Excel,
then copy that name list into LookoutDirect.

•

In a process using multiple duplicate driver objects (such as a gas
pipeline or water distribution system), define a single driver object
database parameters in Excel. Import that database into multiple driver
objects.

Although you can import and export any object database, you may find that
these services are most useful for objects with large native databases, such as
driver objects and Data Table objects.

Exporting an Object Database
Follow these steps to export an object database:
1.

Open the Edit Database dialog box, either through the menu or the
Object Explorer, choosing the object you want to export from.
The following diagram shows a Modbus object that already has a number
of logical and numeric data members defined.
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2.

In the database dialog box, click on the Export button.

3.

In the Export Object Database to dialog box, choose a directory path,
enter a filename and click on OK.

When you export a database, LookoutDirect does not export every possible
data member (many driver objects have a capacity for thousands of
members). Instead, LookoutDirect exports configured points; that is, data
members that have at least one parameter already defined. LookoutDirect
also exports native members that are in use (that is, connected to other
objects).
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The spreadsheet file that the LookoutDirect Export command creates is in
Excel Version 2.0 format. An example of the .xls file is shown in the
following illustration.

Creating a Database Spreadsheet
The easiest way to create a database spreadsheet for an object is to create the
object in LookoutDirect, define the parameters for one logical data member,
one numeric data member, and one text member (if necessary). You then
export the database to a spreadsheet file.
This creates a basic spreadsheet file with all the necessary column labels for
LookoutDirect to read. The three data members you edited in LookoutDirect
furnish examples you can follow to rapidly create or edit more data members
of the same type, using the convenient tools of your spreadsheet program.
Notice the figure above, that row 1 contains column labels. These include the
names of all possible data member parameters. LookoutDirect references the
labels of a spreadsheet file, not the column letters, so if you were to create a
spreadsheet to import into LookoutDirect manually, you would have to spell
all column labels correctly. LookoutDirect ignores white space and is
case-insensitive. The following list contains all possible column labels, in the
order in which LookoutDirect inserts them when creating a spreadsheet file.
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•

Command

•

Member

•

Alias

•

Description

•

Prefix

•

Suffix

•

Eng min

•

Eng max

•

Raw min
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•

Raw max

•

Invert?

•

Deviation

•

Force?

•

Forced value

•

Alarm area

•

Lolo level

•

Lolo priority

•

Lo level

•

Lo priority

•

Hi level

•

Hi priority

•

Hihi level

•

Hihi priority

•

Logical priority

•

Log data?

•

Lifespan

LookoutDirect requires the column labels Command and Member. All other
column labels are optional. Command must be in cell A1. The order in which
the other column labels appear makes no difference.
Any time you import a database, LookoutDirect reads the first 30 columns
(A–AD) and ignores columns that do not have labels.
The rows below the column labels (below row 1) each represent a database
data member. For example, row 5 in the spreadsheet in the previous figure
represents the data member whose alias name is FIC101Mode.
You can easily add rows to define new data members. Copy the rows
associated with FIC101, for example, and then modify the new rows slightly
by identifying different native members and giving them new aliases and
descriptions.
After you have edited and expanded your spreadsheet file, you can save it and
import the new values back into LookoutDirect, adding all the new data
members to those your configured earlier as template samples.
If you are working with a version of Excel more recent that 4.0, the program
asks you if you want to update your spreadsheet to a newer format when you
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select File»Save. This dialog box is shown in the following illustration . Be
sure to select No. LookoutDirect does not currently accept Excel spreadsheet
files from versions greater than 4.0.

Importing an Object Database
Editing a spreadsheet file for several similar data members, and then
importing it as an object database, can be much faster than working in the
LookoutDirect dialog boxes one at a time. When you import a database,
LookoutDirect reads the first 30 columns (A–AD) It ignores columns that do
not have labels and columns beyond AD.
Each row in the Command column (column A) contains either the keyword
insert or the keyword delete. When you import a database,
LookoutDirect ignores rows that do not have the insert or delete
keyword. It adds those records whose command keyword is insert. It
removes those records whose command keyword is delete. To determine
exactly which records to delete, LookoutDirect uses the record alias name; or
if the record does not have an alias name, it matches the record member name.

© Automationdirect.com
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Follow these steps to import an object database:
1.

Open the Edit Database dialog box, either through the menu or the
Object Explorer, choosing the object you want to import from.

2.

In the object database dialog box, click on the Import button.

3.

In the Import Object Database from dialog box, choose a directory
path, select the filename and click on OK.
When finished, LookoutDirect presents you with a set of database import
statistics, as shown in the following illustration.
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As you can see in the following figure, the data members added to the
database spreadsheet were successfully added to the Configured points list.

Copying an Object Database
The import and export features make it easy to copy the database of an object.
This is especially useful when creating large SCADA applications, such as
gas pipelines with multiple compressor stations.
The key to defining multiple driver objects that require duplicate databases is
to first create an object in LookoutDirect for each RTU or PLC. Then create
a single database in Excel. Next, import that database into each driver object.

© Automationdirect.com
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Prefix

Meanings

Value

m-

milli-

10 –3

k-

kilo-

10 3

M-

mega-

10 6

A
absolute date
absolute time

Numeric system LookoutDirect uses for keeping track of dates and times,
in which midnight (0 hours), January 1, 1900 is represented by 1, midnight
of January 2, 1900 is represented by 2, and so on. The absolute date/time
number 36234.47222250 represents 11:20 A.M., March 15, 1999.
The numeric value for 1 second in LookoutDirect is .000011574, the
numeric value for 1 minute is .000694444, and the numeric value for 1
hour is .041666667.

ACK

Acknowledge (an alarm or event).

active notification

A feature of event-driven software systems in which the application is
alerted of value changes when they occur instead of through continuous,
loop-driven queries.

address space

An OPC term for the area you browse to find what items are available on
an OPC server. Part of the standard OPC interface, this space may arrange
items hierarchically.

alarm

Software notification of a condition in a process. This alarm may call
attention to a value that has exceeded or fallen below certain levels, set in
the object database or in an Alarm object.

alias

Name given to a data member using the Edit Database dialog box. This
name can be descriptive or mnemonic, and can be associated with other
data member configurations such as scaling, logging, and alarming. A data
member can have more than one alias, each with different associated
configurations.
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B
baud rate

Measurement of data transmission speed, formally defined as the number
of electronic state changes per second. Because most modems transmit
four bits of data per change of state, is sometimes misused or
misunderstood—a 300 baud modem is moving 1200 bits per second.
See bps.

.bmp files

Graphic files in bitmap format. If you are using a .BMP file in
LookoutDirect, you cannot resize it on screen. See Windows metafile.

bps

Bits per second—measure of the rate of transfer of data.

C
CBL compiler

LookoutDirect uses the CBL (Control Block Language) compiler to
compile a LookoutDirect source file (.lks) into a binary file (.l4p).

.cbx file

A LookoutDirect file containing a LookoutDirect object class. A .CBX
(Control Block Extension) file can have one or more object classes in it.

checksum

A method of verifying that the number of bits received is the same as the
number of bits transmitted. Used by TCP/IP and serial protocols.

Citadel

The LookoutDirect historical database that stores your data for access
later.

classes

See object classes.

client

A LookoutDirect process that monitors a LookoutDirect server process.
LookoutDirect clients should be computer independent so that they can be
run from any computer on your network. LookoutDirect server processes
run on computers actually connected to your control hardware.

comm port

Term sometimes used for a serial port.

connection

Input to a LookoutDirect object’s writable data members. For more
information, refer to Chapter 4, Using LookoutDirect, in your Getting
Started with LookoutDirect manual.

control objects

LookoutDirect objects you use to control a process, change a data value,
adjust a register, and so on.

controllable objects

LookoutDirect objects you can control with a LookoutDirect control
object.
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.csv files

Comma Separated Value file, a format widely accepted by spreadsheet and
other data handling programs.

CTS

Clear to Send. Part of a handshaking protocol for certain devices that
connect the serial port of a computer. See the RTS/CTS Handshaking
Settings section of Chapter 3, Serial Port Communication Service, for
detailed information.

cursor (data table)

The LookoutDirect data table can activate one row of data at a time using
the data table cursor. See the Data Table reference in the online help or the
LookoutDirect Object Reference Manual.

D
DAQ

Short for Data AcQuisition.

data member

Data source or sink associated with a LookoutDirect object. A readable
data member, or source, can be used in expressions or as inputs to other
objects. A writable data member, or sink, can have at most one
connection into it, created using the Object»Edit Connections dialog
box. A data member can be both readable and writable.
See also native data member and alias.

data type

Kind of value (numeric, logical, or text) that a parameter or data member
can hold.

database

Collection of data stored for later retrieval, display, or analysis.

datagram

Message sent between objects in LookoutDirect. A datagram contains
a route and a value.

DCOM/COM

Distributed Component Object Model, a Microsoft standard in which
client program objects request services from server program objects.
The Component Object Model (COM) is a set of interfaces, clients, and
servers used to communicate within the same computer (running
Windows 98/95 or Windows NT).

DDE
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Dynamic Data Exchange, currently used in LookoutDirect to exchange
data with other programs (such as Microsoft Excel) running on your
network.
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deadband

A value that must be exceeded for an alarm to sound or a change in state
to be recorded. For instance, if you have a low-level alarm set at 5 with a
deadband of 2, the alarm will not trigger until the value being monitored
drops to 5. The alarm will then stay active until the value being monitored
moves above 7. A deadband keeps small oscillations of value from
triggering an alarm and then canceling it too rapidly.

deviation

Set a deviation to filter out small changes in value when logging data.
Before being logged to a database, a value must change by at least the
deviation amount of the last logged value.

dialing prefix

Part of the Hayes AT command set for use with modems. See the Dial-Up
Modem Settings section of Chapter 3, Serial Port Communication Service,
for detailed information.

displayable objects

A LookoutDirect object class that has a displayable component, such as a
Pot, a Switch, or a Pushbutton.

DLL

Dynamic Link Library, which is a collection of small, special-purpose
programs which can be called by a larger program running on the
computer. Sometimes called Dynamically Linked Library.

driver objects

LookouDirect objects used to communicate with PLCs, RTUs, and other
I/O devices.

E
edit mode

LookoutDirect mode in which you can alter and create objects within a
process. Switch in and out of edit mode by pressing <Ctrl-space> or by
selecting Edit»Edit Mode.

engineering unit

In LookoutDirect, used to refer to scaled or converted data. Thermocouple
data, for instance, arrives in volts as the raw unit, and must be converted
to degrees, an engineering unit.

environment services

Tasks LookoutDirect performs as a part of making your SCADA/HMI
work easier. LookoutDirect environment services include serial
communications, database and logging, security, networking, alarming,
and so on.

Ethernet

A widely used, standardized local area networking technology, specified
in the IEEE 802.3 standard.
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event

Anything that happens can be an event. In LookoutDirect, events include
such things as adjusting a control value, entering or exiting edit mode,
opening or closing a control panel, and logging in or logging out of the
system.

expression functions

Mathematical, logical, and other functions used by LookoutDirect
expressions.

expressions

LookoutDirect expressions are often paths to a data member. They can
also function like variables that, using a spreadsheet cell-type formula,
become capable of performing flexible, real-time math operations,
condition testing, and other complex operations functions. See Chapter 1,
Expressions, for more information on expressions.

F
failover

A failover is the takeover of a process by a standby computer when the
primary computer fails for any reason.

FieldBus

An all-digital communication network used to connect process
instrumentation and control systems.

FieldPoint

A National Instruments hardware product line for industrial automation,
control, monitoring, and reporting.

frame

Sequence of bytes sent from a computer to a device or vice versa. The
syntax of the frame depends on the protocol being used. A read frame
contains enough information to specify a set of variables whose values
the device should return. A write frame specifies a variable in the
device and a new value to write into that variable. Some protocols
support the writing of multiple variables in a single frame. A response
frame is returned from the device to the computer, indicating whether
the frame just sent to it was received successfully. If the frame just
received was a read frame, the response frame contains a set of
requested values.

functionality

The way an object works, operates, or performs a task. Functionality is a
general concept that applies in the same way to all objects in a given object
class. Parameters define the specific functionality of an individual object.

functions

See expression functions.
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G
gray proximity

A term used in LookoutDirect color animation. This sets what percentage
of gray will be replaced by a given color as conditions change in a
monitored value or set of values.

H
Hi and HiHi

Alarm settings. Both warn that a value has gone above some setpoint.
Generally a Hi alarm is used to alert an operator of a need for intervention.
A HiHi alarm is usually used to alert an operator that the value has been
exceeded by an even greater margin than a Hi alarm indicates, and is
usually used to indicate an urgent need for action.

historical logging

The process of storing data in a database for use at another time, or from
another location.

HOA

Hand-Off-Auto control, used to set whether a value must be changed
manually, is completely turned off, or functions automatically. You can
use a Pot object and a complex expression to create this sort of control in
LookoutDirect, or you can use a RadioButton object, depending on the
particular requirements of the task you need to accomplish.

I
I/O point

Every read-only, write-only, or read-write connection LookoutDirect
makes to external hardware is counted as an I/O point. LookoutDirect is
licensed for use with a set number of I/O points. If you exceed the number
you are licensed to use with your copy of LookoutDirect, a warning
message appears on your computer screen warning you to shut down one
of your processes within a specified time before LookoutDirect cuts back
on I/O usage.

(implicit) data member

A LookoutDirect data member containing the fundamental data for certain
object classes. When you make a connection to an (implicit) data member,
you only use the name of the object, not the name of the object followed
by the data member name.
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L
.l4p files

File extension for LookoutDirect process files. These are the compiled
files LookoutDirect runs when it runs a process.

.l4t files

File extension for a LookoutDirect state file, which stores the values for
LookoutDirect controls and other objects with state information.

.lka files

File extension for LookoutDirect security files.

.lkp files

File extension for LookoutDirect process files in versions of
LookoutDirect earlier than LookoutDirect 4.

.lks files

File extension for a LookoutDirect source file, which LookoutDirect
compiles to make a LookoutDirect process file that LookoutDirect can
run. This is the file you should make sure you keep backed up in case you
need to recreate a corrupted process file, or in case some future version of
LookoutDirect cannot run a process file compiled in an earlier version of
LookoutDirect.

logging

The process of storing data in a computer database file. See Chapter 7,
Logging Data and Events, for more information on logging data in
LookoutDirect.

logical data member

A LookoutDirect data member of the logical data type.

.lst files

Extension for the LookoutDirect state file in versions of LookoutDirect
earlier than LookoutDirect 4.

M
multiplex

© Automationdirect.com

A method of working with more than one data stream using only one
communications channel. There are a number of different methods of
multiplexing, depending on the hardware and software being used. A
number of LookoutDirect driver objects support multiplexing hardware.
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N
native data member

Data members built into a LookoutDirect object class, as opposed to data
members you create by using aliases.

NetDDE

A way of networking using DDE (dynamic data exchange), retained in
LookoutDirect 4 for compatibility with earlier versions of LookoutDirect.

numeric data member

A LookoutDirect data member of the numeric data type.

O
object

A specific instance created from an object class.

object classes

Software modules you use to create individual objects to perform tasks in
LookoutDirect.

object connections

Software links between objects used to transmit data and commands from
one object to another.

ODBC

Open DataBase Connectivity, a standard application programming
interface (API) for accessing a database. You can use ODBC statements to
access files in a number of different databases, including Access, dBase,
DB2, and Excel.
ODBC is compatible with the Structured Query Language (SQL)
Call-Level Interface. ODBC handles SQL requests by converting them
into requests an ODBC database can use.

OPC

OLE for Process Control, an industry standard interface providing
interoperability between disparate field devices, automation/control
systems, and business systems. Based on ActiveX, OLE, Component
Object Model (COM), and Distributed COM (DCOM) technologies.

P
parameter

Input to an object, similar to a writable data member, whose value is
specified in the object parameter list in a LookoutDirect source (.LKS)
file. Typically, parameter values are set in the object Object»Create or
Object»Modify dialog box.

ping

A small utility program in Windows and DOS that checks to see if a
computer can be reached across a network. Also used to indicate the
running of that program.
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pixel

Picture Element, the smallest bit of a picture. Has one color or shade of
grey. The number of pixels per inch determine the resolution of an image.

PLC

Programmable Logic Controller.

poll

A software event in which a computer checks some value in a device or
register. In LookoutDirect, a logical command that forces a device poll to
check data member values.

poll rate

How often a device is polled.

pop-up panel

One variety of LookoutDirect control panel that can only be displayed at
the size set by the process developer, and which cannot be maximized.
When open, a popup panel remains on top of other panels until minimized.

process

In LookoutDirect, process refers to a LookoutDirect “program”, used for
industrial automation, control, monitoring, or reporting.

process file

The LookoutDirect binary file LookoutDirect executes when running a
process. Carries the .l4p extension.

R
raw unit

Data as it arrives in your process, such as voltage or amperage.
Thermocouple data, for instance, arrives in volts as the raw unit, and must
be converted to degrees, an engineering unit.

receive gap

A serial communications setting that determines the number of empty
bytes (or amount of time) a driver receives before recognizing the end of
a message frame and requesting another message. See the Setting Receive
Gap section of Chapter 3, Serial Port Communication Service, for more
information about the receive gap.

redundancy

A system for making sure that a computer can come online and run a
LookoutDirect process if the computer currently running that process fails
for some reason.

remote

In the context of LookoutDirect, remote is a position source location for a
control. See the Remote Position Source section of Chapter 4, Using
LookoutDirect, in the Getting Started with LookoutDirect manual for
detailed information on the LookoutDirect remote position source.

resolution

The smallest signal increment that can be detected by a measurement
system. Also, the number of pixels per inch on a computer monitor screen
or dots per inch in printer output.
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RTS

Request to Send, part of a handshaking protocol for certain devices that
connect the serial port of a computer. See the RTS/CTS Handshaking
Settings section of Chapter 3, Serial Port Communication Service, for
detailed information.

RTU

Remote Terminal Unit, a device similar to a PLC for use at a remote
location, communicating with a host system through radio or telephonic
connections.

run mode

LookoutDirect mode in which processes run but no editing changes can be
made. Switch in and out of run mode by pressing <Ctrl-space> or selecting
Edit»Edit Mode.

S
SCXI

Signal Conditioning eXtensions for Instrumentation, a National
Instruments product line for conditioning low-level signals.

security accounts

Also called user and group accounts, LookoutDirect uses security
accounts to define what users or group of users have different operation
privileges in LookoutDirect. See Chapter 6, Security, for detailed
information on LookoutDirect security.

server

A process that provides data (services) to client processes. In
LookoutDirect, server processes are intended to be run on one computer
only, with direct connections to field hardware. Client processes interact
with field hardware through server processes.

source file

LookouDirectt file that can be compiled to produce a binary
LookoutDirect process file that runs a process. Uses a .lks file extension.

SQL

Structured Query Language, used to get information from and update
information in a database.

standby

A computer standing by to take over running a process if the primary
computer fails or falls offline.

startup file

A LookoutDirect process file (.l4p) you designate in the System
Options dialog box that LookoutDirect will open and run any time
LookoutDirect is opened.

state file

The LookoutDirect file that stores the value of all LookoutDirect control
parameters and object data members in use in a process. Uses the file
extension .l4t.
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system objects

LookoutDirect objects used to control other objects or process and analyze
data.

T
TCP
TCP/IP

Transmission Control Protocol, a method (protocol) for sending data
between computers. Used with IP, the Internet Protocol.
TCP/IP sends data as packets, with IP handling the delivery of data and
TCP keeping track of the individual packets.

text data member

LookoutDirect data member used for text data.

trace

A term for data from a single source over some period of time, stored in
an ODBC-compliant database.

traces table

ODBC databases present data in the form of traces tables. A traces table
contains a field or column of data for each data member being logged,
along with a field you can use to query the database.

trend

Historical data showing the change in a value over time. Often used in
connection with graphing the data for display.

W
.wav files

File extension given to sound files. You can play a .wav file in
LookoutDirect to add sounds or speech to alarms or events.

Windows metafile

A standard graphics file type for use in the Microsoft Windows operating
environment. If you use a metafile graphic in LookoutDirect, you can
enlarge or reduce it on the screen, use them as masks without specifying
transparent pixels, and use the LookoutDirect Animator to animate the
colors of the graphic.

.wmf files

File extension given to Windows Metafile graphic files.

X
.xls files
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File extension given to Microsoft Excel files.
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